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This document outlines how to configure Medication Review functionality in Kroll and the
process of completing Medication Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the Medication Review functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters | E | [&J
General Qonfiguration| Modulesl IherapeuticAdvisurl §tati0n| Logging|

I Allow Electronic Signatures I Follow Provincial Legislative Rules for Fx Transfer
[C] Enable Set Laser labels
[ Allow NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

= P9

w Store Level Configuration Parameaters

General F'atientl Dug I Doctorl Fix | FDE | .&diudicationl Labelsl Heportsl Securit_l,ll Interfacesl Dldell ><-.-’-‘«HI ¥ -To Do| ECtrl E

Allgws User Calars [ Alvways Show Scan [ Display ‘Window 'When Services are Dawn
Allows Colurnn Canfiguration

Frompt to exit when clozing fill applization |Jge automatic capitalization

Enable MH / batch . )
e - Use Unit Dose Packaging | 2] Allow Electioric Signatures |
Default language | English J Default area code Enable Ctrl-PrintScreen to Print Screenshot
Default Country Canada ﬂ Sort Rx Transfer Stores By Store Mame j

Store Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

w’ Store Level Configuration Parameters E =

| Generall F'atientl Drug I Doctorl Rz I FDB I .-’-‘«diudicationl Labelsl Heportsl Securityl Intelfacesl Drderl ><-AF|| Y- Ta Do| [ECtrl @
| ‘I-Generall 2-F'ricing| 3-Prompting| 4 - Mursing Homel 5 - Background Fx FiIIingI B-Workflowl ?'CDUHSEHHQI 8-EeFI:-:|

R Caunzeling Autarnatic Patient Counzeling
Allow editing counseling time On Mew R
Require Electronic Signature Only flag if patient hazn't had the drug inthe last 180 days
Uszers Permitted to Finalize Accepted Counseling [C] Or Refils
Fharmacist Licersed Technician [] On Drug Changes
Pharmacist Intern Pharmacy Tech Student Allows Uger bo Turn OFF Automatic Coungeling for an Bx
Fharmacy Student Pharmacy LAssiztant
IT Suppart

Yizible Tabs
Hardcopy T ab RxImages Tab
RxTab “wiorkflow Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Reguire Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews

Fequire Electronic Signature

Allow Editing Caunzeling Time

T

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

e Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based Medication Review using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of Medication Review;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic Medication Reviews

This section explains how to perform an Electronic Medication Review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper Medication Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

[ w* Store Level Configuration Parameters |.E.| LJ-Eh ]
| ﬁenelall Eatienll Dirug I Dgctorl Bix | FDB I ﬂdiudicationl I__abelsl Heporﬁsl ﬁecurityl lnterfacesl Dldgrl 5-AH| ¥-Ta Do| [Ectrl E

1- Generall 2 - Pricing| 3- Prompting| 4 - Mursing Homel 5 - Background Rx FiIIingl E -Workflowl i- Eounselingl 8- EeFiH|
Dirug Programs

Prompt to use Drug Subs [T Automatically use Drug Subs [] Patticipate in the R Canada / Health Inform Program

Usze Dug Subs when Batching

Frompt [f Doctar Refused Repeat When Cancelling Rix [] Patticipate in the Pharmacy Access program

Prompt far Comments when Canceling an Bx [ Use Station Name Subdirectaries Far Phamacy Access
[ Always require comment Days Back: 365

[ Prompt for Comments when Inactivating an Rx [] Enable Rx Canada Pragram [RxG ateway]

[ Abways require comment
[ Prompt for Patient Counzeling on new Fx Services . . ) . )
P to Batch NH B [ Prampt to Enral Patients in Refill Reminder or Auto Refill Frogram

fampin Bats ) e ) , ) Prarmpt to Enrol MH Patients in Refill Reminder or &uto Refill Frogram

Emmpt ;\Ihe; nak d'S::ES'n%aS ':.I'ug s PF‘?Ck Size Prompt to Enable Rxs for Refil Reminder and Auto Refil Program
W t I . . -
fompL For REpsats er.1 CPping an Fis . Enral Patients for Pickup Matification Mo j
Prarpt To Use Manual Price From Last Refil

[7] Riemave Manual Prics for Batched Fixs Enral WH Patients for Pickup Notification No ﬂ

[ Prampt if Dioctor Authorization Received for Narcatic Rxs

[ Check far High Intensity Drugs Prompt to copy workflow packaged info for cancel and refil Rxs
Frompt if there iz not enough irveentary to fill the Bx Frompt ta copy to new number if refiling an By with no repeats

[ Prevent Copying an Inactive Rx to a New Mumber [ Prompt for Due D ate on autofil batches

[ Show lacal patient prafile an fill [] Prampt far T camment an autafil batohes

Prampt to Copy "Mistake' Rus to a New Number Sawe Route code from Ry az default value if no default is zet Ask ﬂ

[ Show thermal/dat matrix label canfig an autafil
Save Form code from Ax as default value if no default is set - Ask ﬂ

[ Prarnpt ta Print Script Image Far 13t Fill af an Unfiled Ry

[ Prarapt far AADL Plan Infarmation if 54 number iz NOT zet Prarmpt for Medication B eview
rack Medicahon Heview Rejection Beazon:

Allove "Mever Prompt’ For Medication Review

[ Prarapt if ' az Undeliverable when Canceling an Fx

Search o OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

ef Selectan Option = &=

This patient may be eligible for the (BMR) Basic Medication Review program.

| Add to Med Review Queue |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| Undecided |

e Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing Medication Review ‘Saved for Later’ for further
details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

o Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow “ F11 - Drop-off ” F12 - New Rx “ Alt-X - Start ]
Last Name Doe First Name Jane salutation Ms. j _ Save Patient
Profil
Address1 100 Main St Phone Numbers (1) Birthdate  01/01/1980 —
Description |Phnne | All Rxs
Address 2 Age 34 years
J J Cell (555) 555-5555 J Active Rxs
City Charlottetown =| Prov PE |~ Gender Female - i il
- Ne [gedsEEable Active Rxs w/Passtimes
Pastal M1M 1M Country Canada j Llanguage English j
Refillable Rxs
Email Famlly Doctor Height - )
Pricing Profile
Quick Code [eiGh (Ltoad ][ Detete | Mot Disp./OTC Rxs
J
Comments (0) (Del) =
— (2 ops J Rxs Filled in Error
Topic Comment
Plans (1) (F2) (T 0= Suspended Rxs
| subFlan Code| Group ID | Client ID |Epiy |
1 VET 11111 Perform FDB Analysis
View
Alternate Addresses
- Batches
Allergies (0) General l Family ] COpaygl COmmgnications] Other ] o [
R Charting
Patient Consent
Active Consent Unknown Consent
i Credit Cards
A |
nimal - 1 Unit Dose b "
Deceased On Type <Mones> j geuments
Medical Conditions (0) Medication Review/Dialogs (15) I
Prescriptions Cycle <None> -
Rx Counseling Histo
Delivery Type _ Default (Pickup) " Price Group _ <Defaylts (<None>l w| J ¥

3. The Medication Review profile will appear. Click N — New Review/Dialog.

«* Patient - Helvey, Ricky P B|l= = =
File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F3 - Workflow F10 - Pickup “ F11 - Drop-off ” F12 - New Rx " Alt-X - Start
Last Name Helvey First Name Ricky Salutation j _ Save Patient
- - Profile
N - New Review/Dialog All Ras
Medication Reviews (0) = Active Res
Type Status Fee Status Created ¥ | Complsted o || Active Rxs w/Passtimes
Refillable Rxs
Pricing Profile

The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

(58|
E]

Medication Review/Dialo
g

Type (BMR) Basic Medication Review

I Perform uowl l Save for later l l X cancel l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

w° Medication Review Rx Selection P E|=B] X
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mcg 11-Jul-2014

Select All ] ’ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
v oK

6. The Medication Review Rx Selection screen will appear. Click Next to proceed through the
tabs, completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the (BMR) Basic Medication Review screen appears.
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Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions IMedicaI History | MNon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Ccmments|

-

Who helps you with your Medication
Smaoking <MNot Answered:= j
Other Micotine/Drugs <Not Answered= j

Alcohol Intake <MNot Answereds j

m

Caffeine Intake <Maot Answereds= j

Herbals/vitamins/natural health products <Mot Answered> j

Do you have trouble remembering to take medications as prescribed <Mot Answered> j
Do you think you might benefit from a compliance pack program <Not Answered> j
Kidney Disease <MNot Answered> j

Liver Disease <Maot Answereds j

Tetanus immunization (every 10 years) <MNot Answered> j

Influenza immunization yearly <Mot Answered> j

Dnanmarnccal imminnizatinn fane fifal Aot Ancwarads v |

X save for Later ]

Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I Nan-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Patient Medical History Ins

Currently Taking 7 TAB Synthroid 112mcg [KNO]

Yes j Pink Round Tab Flint 112
Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TABLET OMCE DAILY

Currently Taking 30 TAB Prinivil 2.5mg [MSD]

Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 30
TAKE 1 TAELET EVERY MORMNING

Currently Taking 7 ML Amoxicillin 50/ml [SNS] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7 Comments

TAKE 1 TEASPOOMN(SML)OMNCE DAILY
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For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.

Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

Questions | Medical Historyl Non-Prescription Medications I Rxs From Other Pharmacies | General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements 1ns |[Del
Currently Taking  Claritin 10 mg For seasan allergies
Yes j

X save for Later @ Next

¢ Note if the patient is currently taking any OTC medications and select Yes/No from the
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Use Del buttons to remove any OTC items.
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Rxs From Other Pharmacies

The Rxs From Other Pharmacies tab provides space to record medications that the patient is
taking that were filled in other pharmacies.

Click Ins to add an Rx from another pharmacy.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Prescriptions From Other Pharmacies

From - Smith's Pharmacy - (555) - 123-4567

Currently Taking  Tylenol # 3 - Take 1 to 2 tablets up to 4 times a
Possible duplication of therapy

Yes j day when needed for pain

From - Duncan Mill Pharmacy - (355) - 555- 5555

Currently Taking  gisoprolol 5mg - take 1 tablet daily
Duplication of therapy

Yes -

x Save for Later O Mext

Note if the patient is currently taking any other medications and select Yes/No from the

[ J
dropdown list.

e Enter the name of the medication in the Medication field.
e Enter any appropriate comments in the Comments field.

Repeat the same process for any Rx items that they have purchased from other pharmacies.
Use Del buttons to remove any Rx items.




I—N\
% ’ LL Medication Reviews - Prince Edward Island
ompuler Systems Inc.
N

General Comments

The General Comments tab provides space to record any comments you want included on the
report printout.

| Questions | Medical History | Non-Preseription Medications | Rxs From Other Pharmacies | General Comments | pharmacist Comments |

Pharmacist Comments

© Next

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments |

[ |
—— [ ]

7. When you are finished click Finalize Review.

10
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8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the Medication Review was physically conducted in another location (LTC facility, patient’s
home) other than the pharmacy, enter the name of the location and the address. Complete
the Other Professional Involved fields if another health professional assisted with the

review.

When you are finished, click OK.

=% Medication Review = 22

Time spent: 00:30 On 14/07/2014 By Pharmacist (P) j

Assessment Location

Name Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toranto, ON M3B 315

Other Professional Invaolved

MName T

Title Technician

Phone

| vok | | XCanceI|

11
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Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

The patient signature appears once the patient signs on the electronic signature tablet.

12
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10. Have the pharmacist sign the electronic signature tablet.

11. When you are finished, tap Done on the signature tablet.

Printing a Medication Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The Medication Review report print form will appear. Select the appropriate print options
and click Print and provide this copy to the patient.

Billing a Medication Review

14. Once printing is complete, the Fee For Service Claim will automatically populate in the F9-
Professional Services Queue. Press F to bill the claim. If necessary, perform a doctor search
to locate the pharmacist to use as the prescriber and ensure all other information entered
on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the Medication Review includes a license number that is identical to the license number of
a Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

13
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15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

File Edit Rx View Labels Profile Reports Utilities Central Fill Cards Session Help
l F3 - Patient " F5 - Drug " F7 - Doctar l F9 - Workflow F11 - Dre I F12 - Fill Rx || Alt-X - Start
First Fill Last Fill Information
0 MNewRx  Pending Adj 06/08/14 | 0 0 Oty 5000 Init
Priority Default Wait Time ﬂ Due in 19 mins Forward Rx Work Order 31 Delivery Pickup j
Fatient Search Drug Search Pack J Dot Search Loc Office j
Mame | Doe, Jane Age34  |Brand Mame | Dr. Test, Doc
Address | 100 Main 5t Female | | Generic Address
City Charlottetown Prov |PE Pack Form Sched City Prov ON
Phone |Cell (555) 555-5555 Purch OnHand |0 Mo image |[Phone |(555) 555-5555
Plan  |VET ClientID 11111 DIN Min Qty |0 Lict¢ |13 Alt. Licg|321
Alleraies Sig (BMR) Basic Medication Review Init | KRL |KRL Auth Qty L
(BMR) BASIC MEDICATION REVIEW Disp Oty Refills(+)| Rem Qty 0
G.P. % 0
Days 1
. Acq Cost
Cenditions Prod Sel 3- Pharmcj Cost $0.00
Coute of Adm j oW Written ﬂ Markup 50.00
oute of Admin Labels 1 Fee e
Eosaacliony El Total 50.00

Medication Review Options

Several Medication Review options are available from the right navigation pane on the (BMR)

Basic Medication Review screen.

File Edit MedReview View Profile Utilities Central Fill Cards Session Help

F5 - Drug F7 - Doctor F9 - Workflow F11 - Dro F12 - New R

(BMR) Basic Medication Review Reviewed With | Doe, Jane (In Person) :i:':"edicatm —
Patient Doe, Jane Address | 100 Main S5t Select Rxs for review
Bith | 01/01/1980 | 34 years Female | Plan | VET Client 1D | 11111 Phone | Cell (555) 555-5555 View Follow Ups
Allergies Conditions View

Patient Charting
Patient Documents

Patient Med Reviews (11)

Questions | Medical H\storyl Mon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments

-
Who helps you with your Medication
Smoking <Mot Answered> j

Other Nicotine/Drugs <MNot Answered= j

Alcohal Intake <Mot Answered> j

Profile
All Rxs

Active Rxs

Active Rxs wy/Passtimes
Pricing Profile

Not Disp/OTC Profile

14




Computer Systems Inc

\//S( KROLL Medication Reviews - Prince Edward Island

Review

Print Medication Review

When this option is selected, the Medication Review report screen will appear, allowing you to

set various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

-
wf Medication Review Report ((BMR) Basic Medication Review, 2014-Aug-06) (B)l= i
Eile

Options

|1 Print store lago
Print Pharmacy Mame, Address and Phone nurmber

Pharmacist:

Krall |

Frint atleast 1 % lines for Allergies
Print at least 1 % lines for Conditions

Max 6 lings in total for Allergies and Conditions

Lines for Comments ]
Cad
=

Extra Lines for fallow-up 3

Printer Microsoft XPS Document Writer j Copies 1=
Tray  Automatically Select j Collate [ Duplex
IBestore Defaults] [ o Erint ] I Presiew I I X Close I

Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the Medication Review Annual Review
screen. Click OK to save any changes and Cancel to close the screen.

15
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«* Medication Review Rx Selection ®» @Bl B P
Pre-Selected (3) | Other Rxs l Unfills | Not Dispensed | Discontinued
Rx Num Drug Fill Date
¥} 1000962 Synthroid 112mcg 14-Jul-2014
v} 1000961 Prinivil 2.5mg 14-Jul-2014
V| 1000960 Amoxicillin 50/ml 14-Jul-2014
Select All | Select None J
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default LI
 OK [ % Cancelj

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the Medication
Review has been completed. This is NOT a Medication Review Followup review.

«f Medication Review Follow-ups | ® | | = |6 &J
Medication Review Print Report
Type  (BMR) Basic Medication Review Completed On
Patient Doe, Jane Completed By

Follow-ups (0)

!Reason Brand Name FxMurn |Resolved | -

m

To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you
are finished, click Save.

16
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= Medication Review Follow-Up o Bl =] B [t
Medication Review
Type  (BMR) Basic Medication Review Completed On
Patient Doe, Jane Completed By

) Do not follow up

19! Follow up required in days =

Reason Unknown j
Comment
[ Resalved on by
Comment

[  save ] ’ X cancel ]

View
Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

« Patient Charting EBllo= P9
Weight | Height | Blood Pressure | Blood Sugar | Cholesterol [ Creatinine CL { INR { Clozaril GI<UE]
o Weight Values (3) [F2][Ins)(Del)
20 : | _|pete|weight .
] e j2013 65
= : : _ _ 1m0z 60

210 A ;i A : . L. 0B/01/2011 58

i
o
m

OlJantl OMarfl 0agh Ol OfSeptl OOl Olanl2 OWANEZ 0IMayi2 OlUllZ 01Sepl2 OlkoviZ Ollani3

X o

Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

17
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Patient Documents
When this option is selected, the Patient Document List will appear displaying a list of

documents associated with the patient.

= P

Patient Document List

N 5 I Add Mew Document W

Documents (1) [FZ] (Tng) (Del)
Title Init |Document Type|Created ¥ |Retain Until |

(BMR) Basic Medication Review

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the
Medication Review queue.

-

%* Patient Medication Reviews and Dialogs N B o B8] =

N - New Review/D P - Print/Reprint F - Ca ) C - Cancel Claim
_F2-ViI‘WMi|$ D - Pharmacist Declinec R - Patient Refusec |
Medication Reviews (1) (FZ)[1n-) (D)
Type | Status | Fee Status |Created ¥ |Completed | -

{BMR] Basic Medication Review Pending Review Mot Completed Yet 06/08,2014

Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the Medication Review Annual Review screen is identical to the Profile
menu on the patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/

Passtimes, Pricing Profile, and Not Disp/OTC Profile.
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Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘saved for later’ or added to the Med Review Queue via auto
prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue appears with all the Med Review records that are pending
review.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow " F11 - Drop-off " F12 - New Rx " Alt-X - Start

Last Name Taylor First Name Barbara Salutation Ms. j oK Save X cancel
N - New Review/Dialog P - Print/Reprint

F2- View Details D - Pharmacist Declined R - Patient Refused

Medication Reviews [10] [F2] (Trs] [Del|
Tvpe |Status |Fee Statuz Created ¥ |Eompleted | -
{EMR) Basic Medication Review Pending Review Mot Completed Yet 06/08/2014

c) Select the Medication Review record you want to complete and click F - Call Up.
F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help
|

I F3 - Patient F5 - Drug | F7 - Doctor ‘ F Workflow F11 - Drop-off F12 - New R Alt-X - Start

M d . t R . P - Print/Reprint e Refresh Workflow Actions

€aICallON REVIEWS 5 pharmacist Declined R - Patient Refused  space - Mark Rxs Ré's To Do

Patient | Type | status | Fee Status | created | Completed| » | Rx'sn Progress

Dukes, Gearge [EMR] Basic Medication Review Pending Review Not Completed Yet 15/08/2014 Pending Adjudication (0)
Dukes, George (EMR] Basic Medication Review Pending Review Mot Completed Yet | 07/05/2014

Dukes, George (BMR) Basic Medication Review Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Trouble (0)

2. Complete steps 3-8 of the Creating an Electronic Medication Review section.
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Sample Electronic Medication Review Report

(BMR) Basic Medication Review

Ty
=R
PEl FharmaCheck

|:|N0 DYes.#cigareﬂesfday: |:|No DYes.#drinksMeek:

|:| Nao |:| Yes, # cups/day:

T
Name Gender Date of Birth
Doe, Jane Female 01-Jan-1980
Address Phone FRN
100 Main St, Charlottetown PE M1M 1M1
FamilyDoctor Family Doctor Fhone Family Doctor Fax
Alergies
Conditions
Smoking Alcohollntake Caffeine Intake OthefVicotine/Drugs

|:| Mo |:| Yes:

Health Information

Herbalshitamins/naturalhealthproducts ¥es| No | Doyou have trouble remembering to take medications as prescribed Yes| No
KidneyDisease Yes| No | LiverDisease Yes| No
Tetanus immunization (every 10 years) ¥es| Mo | Influenzaimmunization yearly Yes| No
Pneumococcalimmunization{one/life) Yes| No | Doyou thinkyou might benefit from a compliance pack program Yes| No
OhenmmunizaionsiraveNacCines
TThat rsyourﬁrggesi CONCErmabod yourmeﬂrceirons EEE_',’
NameofMedlcgllon Strength/Dose Howtotakelhls MEdIG&tIOF Purpose Comments Prescriber
Brand/Generic (frequency, timeof day, etc.)

Amatine 2.5mg- 30 TAB | TAKE 1 TABLET ONCE DAILY Dr. Test, Doc
642Tablets 65mg- 30 TAB | TAKE 1 TABLET ONCE DAILY Dr. Test, Doc

The Frince Edward Island F : iation in with the Ganadian Phamacists Association

have adapted the CPhA PhamaCheck™ program to mest the nesds of Prince Edward lslanders.

PhammaCheck™ is 3 trademark of the Ganadian Phamacists Association and is used under lisense.

Page 10f 2
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(BMR) Basic Medication Review

Accuracy of this listis dependent on the truthfulness and completeness ofinformation provided by the patientand itremains at all times the patient's responsibility to advise their

pharmacist of any change to their medications. By signing this, | consent for my pharmacistto share this medication listwith my other health care professionals (presentand future)
to enhance seamless continuity of care.

Lellon (s woome _ Yosmper|

Patient Signature Date Kroll

The Prince Edward Island P ists Associatian in jon with the Canadisn Phamscists Association
have adspted the CPhA FhamsCheck™ program fo meet the needs of Prince Edward Islanders.
PhamzCheck™ is 2 frademark of the Canadian Phammacists Association and is used under license.

Page 2 of 2

Viewing a Completed Medication Review

With Electronic Signatures Enabled
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow “ F11 - Drop-off “ F12 - MNew Rx “ Alt-X - Start ‘
Last Mame  Taylor First Name Barbara Salutation Ms. j OK Save X cancel

N - New Review/Dialog P - Print/Reprint F - Call up

F2 - View Details

Medication Reviews [10] [Inz] (Del)
Type |Status |Fee Statug | Created T |EomDIeted | -
[BMR] Basic Medication Review Pending Review Mot Completed Yet 06/08/2014
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4. The Medication Review View screen will appear. Click the various tabs to see the

Medication Review information that has been entered.

Medication Review View |EJ&J
(BMR) Basic Medication Review
Created 06-Aug-2014 01:15 PM Status | Pending Fee Status | Review Not Completed Yet Fee Rx N/A
Started 06-Aug-2014 01:15 PM | Duration  Reviewed By | Kroll View Signatures
Completed | NFA NfA Reviewed With | Unknown

Medical History | General Comments | Pharmacist Comments | Non-Prescription Medications | Rxs From Other Pharmacies | Questionsl
Patient Medical History

5. Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or

patient’s electronic signature.

Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will appear. The Review tab displays information

entered on-screen during the Medication Review; the Documents tab displays the scanned
image of the signed Medication Review. Scanned paper Medication Reviews is also viewable

from Patient Documents.

Medication Review View - - & 2
(BMR) Basic Medication Review [ X Close
Created 30-Jul-2014 02:25 PM Status  Completed Electronic Fee Status  Claimed Fee Rx 1087677

I Review Documentsl
Started 30-Jul-2014 02:25 PM Completed | 30-Jul-2014 02:26 PM Duration | 1m Os € t ( Brint
Reviewed By Scott Belfer Reviewed With | Belfer, Scott (In Person)

Medical History | General Comments | Pharmacist Comments | Non-Prescription Medications | Rxs From Other Pharmacies | Questionsl
Patient Medical History
|

5. Click Print to print the Medication Review.
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Paper Medication Reviews

This section explains how to perform paper Medication Reviews. Paper Medication Reviews
must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

.
=¥ Store Level Configuration Parameters

=)

| Qenerall Eatientl Drug | Dgctor|

Rix | EDE | Qdiudicationl Labelsl Hepor_tsl ﬁecurityl 1nterfaces| Drdgrl K-f-‘«Hl Y-Ta Dol

[ ctr [=

1- Generall 2 - Pricing| 3~ F'mmpting| 4 - Mursing Homel 5 - Background R FiIIingl E- Workflowl i- Eounselingl 8- EeHH|

Prompt to uge Drug Subs [T Automatically use Drug Subs
IJze Drug Subs when Batching
Prampt If Doctor Fefused Repeat when Cancelling R=
Frompt for Comments when Cancelling an B=
[ Abways require comment
[] Prampt for Comments when Inactivating an R
[ Always require comment
[] Prampt for Patient Counselling on new Rx
[] Prompt to Batch MH Rxs
Prampt when not dispenzsing as dug's Pack Size
Frompt For Repeats “When Copying an Bx
Prompt Ta Use Manual Price From Last Refil
[7] Remaove Manual Price far Batched Rxs
[] Prampt if Doctor Autharization Received for Marcotic Rxs
[7] Check for High Intensity Drugs
Frampt if there is nat enough insentary to fill the R
[] Prevent Copying an Inactive Rx to a Mew Murmber
[] Shaw lacal patient prafils on fill
Frompt to Copy "Mistake' Bz to a Mew Mumber
[] Shaw thermal/dat matrix label config on autafil

[] Prampt to Print Script Image for st Fill of an Unfilled Fix
[] Prampt for AA0L Plan Infarmation if 54 number is NOT set

[] Prompt if “was Undeliverable when Canceling an R

Drug Programs
[] Participate in the Rx Canada / Health Inform Program

[] Participate in the Phaimacy Access program
[7] Use Station Mame Subdirectaries For Pharmacy Access
Daysz Back: 365

[7] Enable Rx Canada Program [R=G ateway)

Services
[] Prompt ta Enral Patients in Refil Reminder or Auta Refil Program
Frompt to Enrol MH Patients in Befill Reminder or Auto Refill Frogram
Prompt to Enable Ruz for Refill Reminder and Auto Refil Program

Enrrol Patients for Pickup Matification Mo j
Errol MH Patients for Pickup Motification Mo j

Prampt to copy warkflow packaged info for cancel and refill Rxs
Frompt to copy to new number if refiling an Bx with no repeats
[] Prampt far Due D ate an autafil batches

[] Prampt far Tx camment an autafil batches

Save Route code from Ry a3 default value if no defadlt is set Ask j

Save Form code from Fx as default value if no default is st Ask j

|7] Prompt for Medication Review |
|| Track Medication Review Hejection Beason:
Allow ‘Merver Prompt’ For Medication Besview

Search " DK
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When the option ‘Prompt for Medication Reviews’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user

is prompted and presented with a number of options as shown below.

w Select an Option ]

This patient may be eligible for the (EMR) Basic Medication Review program.

P

l Print Report Mow J
[ Print Report Later l
[ 1 have Other Rxs to fill for this patient l
[ Do not prompt me until the next time the patient comes in. l

I Do not prompt until ... ‘

| Never Prompt for this patient |

Print Report Now: This will call up the Medication Review report so you can select the
items you would like to print on the report.

Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing Medication
Review ‘Saved for Later’ for further details.

I have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs
for the patient before printing the report.

Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

24



% !Smﬁege}n-ﬂ!: Medication Reviews - Prince Edward Island

Creating a Paper Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow “ F11 - Drop-off ” F12 - New Rx “ Alt-X - Start ]
Last Name Doe First Name Jane salutation Ms. j _ Save Patient

Profil
Address1 100 Main St Phone Numbers (1) Birtndate  01/01/1980 o
Description |Phnne | All Rxs
Address 2 Age 34 years
J J Cell (555) 555-5555 J Active Rxs
City Charlottetown =| Prov PE |~ Gender Female - i il
- No JgHERRable Active Rxs w/Passtimes
Pastal M1M 1M Country Canada j Llanguage English j -
Refillable Rxs
Email Famlly Doctor Height - .
Pricing Profile
Quick Code [eiGh (Ltoad ][ Detete | Mot Disp./OTC Rxs
J
Comments (0) (Del) =
— (F2)m=te) ops J Rxs Filled in Error
Topic Comment
Plans (1) (2] (Tns) (Bel) Suspended Rxs
| subFlan Code| Group ID | Client ID |Epiy |
1 VET 11111 Perform FDB Analysis
View
Alternate Addresses
- Batches
Allergies (0) General l Family ] COpaygl COmmgnications] Other ] o [
X Charting
Patient Consent
Active Consent Unknown Consent
Animal Credit Cards
nimal [ Unit Dose D
Deceased On Type <None> j ocuments
Medical Conditions (0) Medication Review/Dialogs (15) I
Prescriptions Cycle <None> -
. Rx Counseling Histo
Delivery Type _ Default (Pickup) " Price Group  <Default> (<None>) »| J ¥

3. The Medication Review queue will appear. Click N — New Review/Dialog.

& Patient - Helvey, Ricky ®Bl|l= B =

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session  Help

F3 - Patient F5 - Drug F7 - Doctor Fa - Workflow

Last Name  Helvey First Name Ricky Salutation j ok — Patient
Profile
N - New Review/Dialog

F10 - Pickup “ F11 - Drop-off " F12 - New Rx " Alt-¥ - Start

All Rxs
Medication Reviews (0] = Active Rxs
Type Statuz Fee Status Created ¥ | Completed a Active Rxs w/Passtimes

| | Refillable Fas

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Print Now. If you wish to add to the Med Review queue in order to print the
Medication Review later, click Save for Later.

w Medication Review/Dialog =g

Type (BMR) Basic Medication Review j

I Print Mow I Iga\reforlater] l X cancel ]
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

¥ Medication Review Rx Selection e =B8] =
Pre-Selected (3) | Other Rxs | Unfills | Mot Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112meg 11-Jul-2014
Select all ] [ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
7ok

6. The Medication Review Report form will appear. Select the appropriate print options and
click Print. The report will generate.

Complete the Medication Review on the form. Sign the Medication Review Report and
have the patient do the same.
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Scanning Medication Review Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]
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10. When scanning is complete, the screen will indicate how many pages were scanned
successfully and how many will need to be manually reconciled. When you are finished,
click Process and Reconcile.

Import Scanned Documents |E| l = |
Scanner
Scanner  FUJITSU £i-6130Zdj #2
Mode Colour
Resolution 100 Scan both sides of paper [
Document Processing
To Process 0 I Process and Reconcile I
To Reconcile 0

l View Scan ﬂistoryl ’ X Close l

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will
appear in the Documents to be created section. Items that need to be reconciled will
appear in the Unprocessed Images section.

& Document Scan Reconciliation P®» o B R

Documents to be created (1)

Doe, Jane
Process
= | Pending
Documents
(@ F[zooms00 QA BDBE BB Unprocessed Images (0)) Current Document
| » | Document Images (2) CIEDED
(BMR) Basic Modication Review £ H =
S P erse
1231:45  Patient Med Revie 2
Tare Teoe Tow J5&
Do, lane Somale 01-Jan- 1980
— - s
100Man St Charlettetows P MIN 1M1
| [ TamiyTocks Phore Tenilod e
T E
Tendtars
Ty e TCR AT
Ono [ ves. » opuenenitay One [ ves.» omtsren Ot Jves scowsy One s
[T —
‘ HeN AR TIN SN e MO0 3. ves| 40 |O¢ £ "2 neSCBoey O i
Pineyinsiae veu | 4o | LaaeCasease i e
Tetinus Inmuncaten wvery 0 as. ves | 4o | INPUSTIMTICIBN yeark Yos| M
FRaUmOCICCI W TInCaton snetts veu | 5o | DX yOu Puniyon MON Saneft Bama COMORINCE DICt SO ™ s
"'""""w”':" StreythOove “'.m"‘“'v ::.,”’m Purpcse Commern Pescrmer -
bt 2.5m0- 3) TAB | TaE § TaBLIT ONCE DALY O, Test, Dex
ol - NIN [t it e Document Type Patient Med Review j
patient @
R e R e s a % Name Doe, Jane DOB 24/10/1950
S Paete2 T -+ Address 100 Main St
City, Prov Charlottetown, PE
Med Review
11/07/2014 - (BMR) Basic Medication Review (Printed Paper) LI
| -
f
| Brightness Contrast Saturation
‘ 0 0 0 | X Cancel} [  Next ]
|
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a Medication Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

Completing Medication Review ‘Saved for Later’
1. To call up Medication Reviews ‘saved for later’, do one of the following:
Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue will appear with all the Medication Review records that are
pending review. Select the Medication Review record you want to complete and click F -
Call Up.

File Edit Utilities NH Workflow Cards Session Help

l F3 - Patient FS5 - Drug F7 - Doctor ‘ F9 - Workflow F11 - Drop-off F12 - New F Alt-X - Start

M d - t R . P - Print/Reprint %> Refresh | Workflow Actions
eaication Reviews D - Pharmacist Declined R - Patient Refused  space - Mark Rxs Rx's To Do
Patient | Type | status | Fee status | Created | Completed| » = Rx'sIn Progress
Dukes, George [BMR) Basic Medication Review Pending Review Not Completed Yet 15/08/2014 i
P A
Dukes, George [BMR) Basic Medication Review Pending Review Not Completed Vet 07/08/2014 Eending Adjudication (0)

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

I F3 - Patient F5 - Drug F7 - Doctor ‘ F Workflow F11 - Drop-off F12 - New R Alt-X - Start

M d . . R . P - Print/Reprint c Refresh Workflow Actions
S [Cat' on RevIEWS D - Pharmacist Declined R - Patient Refused space - Mark Rxs Rx's To Do
Patient | Type | status | Fee status | Created | Completed| » | Rx'sln Progress
Dukes, George (EMR] Basic Medication Review Pending Review Not Completed Yet 15/08/2014 .
P A
Dukes, George (BMPR) Basic Medication Review Pending Review Not Completed Yet | 07/05/2014 Pending Adjudication (0)

2. Complete steps 4-14 of the Creating a Paper Medication Review section.
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Sample Paper Medication Review Report

(BMR) Basic Medication Review \_,\

e
FharmaCheck

MName Gender Date of Birth

Taylor, Barbara Female 01-Jan-1980
Address FPhone PRN
100 Main St, Charlottetown PE M1M 1M1

FamilyDoctor FamilyDoctor Phone FamilyDoctorFax

Allergies

Conditions

Asthma, unspecified, with stated statusasthmaticus; Hypertension secondary to endocrine disorders, benign orunspecified

Smoking Alcoholintake Caffeins Intaks Otheicotine/Drugs

[no [ Yes, #cigarettes/day: [Ino []ves, # drinksiweek: [Ino []ves, # cupsiday: [no [ ves:

Health Information

Herbalshitamins/naturalhealthproducts ves | Mo | Do you have trouble rememberingto take medications as prescribed Yes| No
KidneyDisease Yes| Mo | LiverDisease Yes| No
Tetanus immunization (every 10years) Yes | No | Influenzaimmunization yearly Yes| No
Pneumococcalimmunization({one/life) vez | Mo | Do you thinkyou might benefit from a compliance pack program Yes| No
[Omenmmunizaion s eV Vactines
[TTFETTEyo0r Bigge st Concern b 00T Jour EdicalonsTo0sy
Nameoﬂ.’ledicglion Strength/iDose Howtotaketh\sl.ﬂedicatio!-l Purpose Comments Prescriber
BrandiGeneric (frequency, timeof day, etc.)

Cyclobenzaprine 10mg-20 TAB |TAKE 1 TABLET OMCE DAILY Dr. Test, Doc

292 30mg- 20 TAB |TAKE 1TABLET ONCE DAILY Dr. Test, Doc
Clorazepate 15mg-30 CAP | TAKE 1 TABLET ONCE DAILY Dr. Test, Doc
Methyldopa 500mg- 30 TAB | TAKE 1 TABLET OMNCE DAILY Dr. Test, Doc

Calcium Chloride 100mg/ml-30 |TAKE 1TABLET ONCE DAILY Dr. Test, Doc

Injection 100mg/ml ML

Page 1 of 2
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(BMR) Basic Medication Review

NameofMedication Howtotakethis Medication N
Brand/Generic Strength/Dose (frequency, timeofday, etc.) Purpose Comments Prescriber
Apo-Acyclovir 800mg - 20 TAB | TAKE 1 TABLET ONCE DAILY Dr. Test, Doc
Advi Junior Strength 100mg-30TAB | * Dr. Test, Doc
Blue Raspberry
Actonel 30mg-30 TAB | TAKE 1 TABLET OMCE DAILY Dr. Test, Doc
GeneralComments
PATIENT FOLLOWUP
Date Reason Comments

Accuracy of this listis dependent on the truthfulness and completeness ofinformation provided by the patientand itremains at all times the patient's responsibility to advise their

pharmacist of any change to their medications. By signing this, | consent for my pharmacistto share this medication listwith my other health care professionals (presentand future)
to enhance seamless continuity of care.

The Prince Edward Island P

Patient Signature

have adapted the CPhA PhamaCheck™ program to mest the nesds of Princs Edward lslanders.

PhammaCheck™ is a tradamark of the Canadian Pharmacisis Association and is used under ficense.

jon in ion with the Canadian Phamacisis Association

Page 2 of 2

Kroll
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Viewing a Completed Medication Review
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will display the scanned image of the completed
Medication Review. Scanned Medication Reviews are also viewable from Patient

Documents.
Medication Review View . — - — - - - - Bl =
(BMR) Basic Medication Review
Created 30-Jul-2014 02:34 PM Status Completed Paper Fee Status | Claimed FeeRx 1087678
2014-07-30 2:39 PM
4 | =~ = [y f % |
B @ & |zoomos3 % @ @|[0]0 0 G 3|S5
-
(BMI) Basic Medication Review ™
—t
-\f'-'kfrsum naCheck
Tiame [T Tt of o 2
Taylors, Barbara Fenaks: 01D 1990
i G T
160 Mais St Chadatbebown PE M1H 1M1
POy LOCT Famey Docior Fhone FamayLocorhax
T B
sz, unsgecified, with Stated @atus Rthmatious; Hepehension secondany 1o endadine decddes, benign of undpe cfied
Tmctong TocFalliake EoHeine ke TredlcairaBrgs
Oire [ ves. = ciparotosiaay One [ ves = crnicsswas e [ vos.# cupsitay Cre [Jves
Heaith Bnformation
DA AN BTG O vies | nios | Do you hrve wowte re memibenng 1o 1a ke MeACalions a3 pre scised vas| M
KignsDissase Vel | Mo | LiveiDie g8 e el
Tetanu s immunizagon (every 1 years) Ties | e | Infleenzaimmunization yeaty Yes| Me
P UG CClmmLnZal OnCo i) Vet | M | Dy Wink iou magi Benalf Fom 3 compllance pack pogram Yea| Ma
LA e §
TR o (L 17T i M T
Brightness Contrast Saturation
U U J
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Declined and Refused Medication Reviews

This section explains the process for recording Medication Reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click D — Pharmacist Declined.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F9 - Workflow ” F11 - Drop-off || F12 - New Rx ” Alt-X - Start
Last Name Taylor First Name Barbara Salutation Ms. j oK Save X cancel
N - New Review/Dialog P - Print/Reprint
F2- View Details |D - Pharmacist Declined | R - Patient Refused
Medication Reviews [11] [[F2] (Tns] [Del]
Type |Status |Fee Status Created ¥ | Completed | -
[BMR) Basic Medication Review Printed Paper Review Mot Completed Vet 06,/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

k wf Select an Option [EJLi_E-J

Decline/Refuse - (BMR) Basic Medication Review.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

| Cancel |

e [f you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.

e If you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e [f you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.
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Patient Refused

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click R — Patient Refused.

F3 - Patient

Last Name Taylor

F2- View Details

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

N - New Review/Dialog P - Print/Reprint

D L F11 - Drop-off “ F12 - New Rx “ Alt-X - Start ‘

First Name Barbara Salutation Ms. j [s]'4 Save X cancel

F5 - Drug F7 - Doctor l Fo - Workflow

D - Pharmacist Declined R - Patient Refused

Medication Reviews [11] F2][Tng (el
Type |Status |Fee Statuz Created ¥ | Completed | -
[EMR) Basic Medication Review Printed Paper Review Mot Completed Vet 06/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

w’ Select an Option

{53~

Decline/Refuse - (BMR) Basic Medication Review.

I Do not prompt until the next time the patient comes in. ‘

[

Do not prompt until ... ‘

I

Never Prompt for this patient ‘

[

Cancel ‘

o |f you select Do not prompt until the next time the patient comes in you will be
prompted to specify if the review was declined by the Patient or Someone Else.

If you select Someone Else, the Medication Review/Dialog Refusal form will

o
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to
patient menu and click OK.

( & Medication Review/Dialog Refusal (& S
Refused By _ Patient @ Someone Else
Select agent Doe,Jane j
Last name Doe
First name Jane
Relationship to patient@ ~|
[ vox | | X cancel

o No further action is required until the next time the patient visits the pharmacy.
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e [f you select Do not prompt until... you will be prompted to specify the next time you

want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e If you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.

NOTE: Medication Review records that have been either refused/declined by the pharmacist
or patient cannot be deleted from the Medication Reviews queue.

Medication Review Statuses

This section explains the statuses that appear in the Medication Review queue at various
stages throughout the Medication Review process.

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug - Docto F9 - Workflow F11 - Drop-off F12 - New Rx | Alt-X - Start l
Last Name Doe First Name Jane Salutation Ms. j OK | I x Cancel l Patient
~ ¥ Prefile

N - New Review/Dialog P - Print/Reprint F - Call up cel Claim All R

F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews [5) [FZ)(Ins] (Gel] clive s

Type Status | Fee Status |Created ¥ |Completed | + | Active Rxs w/Passtimes
{BMR) Basic Medication Review Pending Review Mot Completed Yet 19/08/2014 Refillable Rxs
(EMR] Basic Medication Review Printed Paper Review Not Completed Yet 310772014 . .

[BMR) Basic Medication Review Completed Electronic Pending Claim 06/08/2014 06/08/2014 =] ||| Pricing Profile
[EMR] Basic Medication Review Declined by Pharmacist Mo Fee Applicable 11/07/2014 11/07/2014 Mot Disp./OTC Rus
[BMR] Basic Medication Review Refused by Patient Mo Fee Applicable 1908/2014 19/08/2014 Rus Filled in Error

Pending
Reviews that have been initiated but have not yet been completed.

Printed Paper
Reviews that have been printed but have not yet been billed.

Completed
Reviews that have been printed and billed.

Declined by Pharmacist
Reviews that have been declined by the pharmacist.

Refused by Patient
Reviews that have been refused by the patient.
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Fee Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow “ F11 - Drop-off “ F12 - New Rx " Alt-X - Start

Last Name Doe First Name Jane Salutation Ms. j 0K | ) X cancel Patient

. . . . S - = ¥ Profile
N - New Review/Dialog P - Print/Reprint F - Call up ancel Claim All Rs
F2- View Details D - Pharmacist Declined R - Patient Refused Active Foc

- - - T = Vi

Medication Reviews (3) oo V™
Type lStatus Fee Status Created ¥ | Completed | ~ | Active Rus w/Passtimes
{BMR] Basic Medication Review Pending Review Not Completed Yet 19/08/2014 Refillable Rxs
(EMR) Basic Medication Review Refused by Patient Mo Fee Applicable 19/08/2014 19/08/2014 — .
(BMR) Basic Medication Review Completed Electronic Pending Claim 06/08/2014 06/08/2014 = Pricing Profile

Review Not Completed Yet
Reviews that have been initiated but have not yet been completed.

No Fee Applicable
Reviews with no associated fees (usually declined or refused reviews).

Pending Claim
Electronic reviews: Completed reviews with a Status of Completed.
Paper reviews: Reviews that have been printed and the option Require Document scan to

complete Paper Med Review is off, and reports that have been printed and scanned back into
the system if this option is enabled.
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